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WINDOWS NT 

 

• What is Windows NT? 

• The Desktop 

• The Mouse 

• The Start button and Taskbar 

• Parts of a window 

• Using Windows menus 

• Using the keyboard 

• Using a dialog box 

• Shutting down your computer 

• My Computer 

• My Briefcase 

• Documents menu 
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WHAT IS WINDOWS NT? 

Windows NT is a Graphical User Interface (GUI) allowing you to issue commands with 
a mouse and manage your applications and files easily and efficiently 

Windows NT will allow you to work with all of today’s Office products in a multi 
tasking environment. It is an operating system that meets the needs of the modern 
office. 

STANDARDISATION 

One of the major benefits with using Windows NT is the standardisation across the 
applications. Many of the commands used (e.g. opening and saving files, printing and 
closing documents) are the same throughout Windows NT applications, therefore once 
you know how to save a file in one application you can save a file in all Windows NT 
applications. 

MULTI TASKING 

Another major benefit of Windows NT is that it allows you to run and work in more than 
one application at a time. When using multiple applications, the Windows can be resized 
to simultaneously view the information in both applications. 

ACCESSORIES 

Windows NT comes with a calculator, a drawing package called Paint and a basic word 
processor called WordPad.  

DATA EXCHANGE 

In Windows NT data can easily be exchanged between applications. This means that 
information from a spreadsheet can be incorporated into a report created in your word 
processing package. In many situations data can be linked between applications ensuring 
that any amendments made to the original data will also be made to the data in the linked 
application. 
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WORKING IN WINDOWS NT 

When working in Windows NT your main work area is the Desktop. You can move 
items around on the Desktop, add new ones to it and remove those you do not need. 

When you start an application it runs in an application window on the Desktop. You can 
reduce any open application window to the Taskbar freeing space on your Desktop 
without closing the application.  

When using multiple applications, the windows containing the applications (i.e. word 
processor or spreadsheet) can be re-sized to allow you to simultaneously view the 
information held in the different applications. 
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THE DESKTOP 

When you start Windows NT you are presented with the Desktop. The Desktop holds 
a variety of icons such as My Computer, the Recycle  Bin and the Start Button. 
These give you access to your applications and files. 

Note: You can customise the Desktop by adding shortcuts to your most frequently 
used programs, documents, and printers to allow you fast and easy access to them. 
This is covered later in this manual. 
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THE MOUSE 

 

The mouse is a key component when using Windows 
It is a pointing device which you use to issue 
commands. Mice have a rubber coated ball on their 
underside which senses your hand movements across 
the desk and replicates them on the screen by moving 
a symbol called the Mouse Pointer. The Mice have 

two buttons which are used to issue instructions to the computer. 

LEFT BUTTON \RIGHT BUTTON 

Both the left and right mouse buttons are used to issue commands in Windows NT. 
The right button being used to issue special commands or to access short cut menus 

CLICK 

Clicking the mouse means tapping the relevant mouse button once. Clicking is 
generally  used to position the cursor or select a single item. 

DOUBLE  CLICKING 

Double-clicking involves tapping the relevant mouse button twice in quick 
succession. This is a timed action and can be adjusted to suit individual needs.  
Double-clicking is usually used to issue a command such as opening an icon on the 
Desktop. 

DRAGGING 

Windows applications work on what is called a “select and issue” basis i.e. if you 
want to underline text you must first drag over the text to select it and then issue the 
command to underline. To select data using the mouse: 

1. Position the mouse pointer in front of the text\item you want to select 

2. Click the relevant mouse button and keeping it pressed in drag the mouse 
 pointer to the end of the required text or item and release the mouse button 
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MOUSE SHAPES 

The position of the mouse within Windows will determine its appearance. The shape 
will indicate the commands that are relevant within that area of Windows. 

Mouse 
shape 

Screen Location Mouse Action 

 

In the Menu and Scroll Bars Used to point, select and issue 
commands 

 

Within text Click to place the insertion point 
where you want to start editing 

 

On window borders Drag to size the window vertically or 
horizontally. 

 
On the corner of a windows Drag to size the window diagonally 

 

In various positions within a 
windows depending upon the 
application 

Unavailable 

 

Near centre of screen when 
you press Shift+F1 for help 

Choose the command or click the 
area of the screen you want help on 

 

Any area of the screen Busy 

 

Any area of the screen Working in the background 
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THE START BUTTON AND TASKBAR 

The Start Button appears at the bottom of your screen, though its position can be 
changed, and it is used to access all applications and programs in Windows NT. 

1. Click on the Start button 

2. Click on the required menu option 

Hint - To access sub-menus point at the relevant menu option and click. The menus 
are “Sticky” and will stay on the screen once clicked allowing easier access to sub-
menus. To clear the Start menu click away into the Desktop or press <Esc>. 

OPENING  APPLICATIONS  

1. Click on the Start button 

2. Select Programs and then the relevant application type i.e. Microsoft Office  
or Lotus Applications  

 

4. Select the desired application 

Note: The open application appears on the Taskbar  
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SWITCHING BETWEEN APPLICATIONS 

1. Click the application required on the Taskbar 

 

 

CLOSING APPLICATIONS USING THE TASKBAR 

1. Click with the right mouse button onto the application on the Taskbar 

2. From the menu select Close 

MOVING THE TASKBAR AND START BUTTON 

1. Position the mouse pointer in an unoccupied area of the Taskbar 

2. Click and drag to the required position 

Note: You will only see where you are dragging the Taskbar to when it reaches the 
top, bottom or sides of the Desktop. 
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PARTS OF A WINDOW 

Most windows have certain elements in common, such as a title bar and a menu bar.  Not 
all windows, however, have every element. 

 

System Button   Title Bar 

 

MenuBar 

Minimise\Restore\Close 



Module 1- Windows NT/98/95 Page 10 of 37  

RHD NETWORK CERTIFICATION   
MODULE 1 – WINDOWS NT 

SYSTEM BUTTONS 

Double-clicking on a window’s System Button will close that window, first prompting 
you to save any data in the window that has not been saved.  

 

 The System Button for Word 

 The System Button for a Word document 

Note: A different icon a ppears for each application  

 

TITLE BAR 

The Title Bar shows the name of the application or document. If more than one window 
is open the title bar in the one in which you are working is blue unless you have changed 
the colour scheme from the default and then it will reflect your chosen colour scheme. 

MAXIMISE, MINIMISE, RESTORE AND CLOSE 

 The Minimise button reduces the program to the Taskbar 

 The Maximise button will maximise the window to fill the Desktop 

 The Restore button replaces the Maximise button after you enlarge a window. 
The Restore  button will reduce the window in size to its previous size. 

 The Close  button will close the application 
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MENU BAR 

The Menu Bar  lists the available menus from which you can choose commands. 

SCROLL BARS 

The Scroll Bars enable you to move through a document or a list when the entire 
document or list does not fit in the window or the allotted space. Click the Scroll Arrows 
with the mouse to move through the document or list, one line at a time or hold down the 
left mouse to move faster. You can also drag the scroll box in the Scroll Bar to the 
position you want. 

 

WINDOWS BORDER 

The Window Border is the outside edge of a window. You can change the window size 
by lengthening or shortening the border on each side of a window. 

Moving the Window Corner shortens or lengthens two adjoining sides of a window 
border at the same time. 
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USING WINDOWS MENUS 

If you select one of the choices on the Menu Bar of a window it will access a pull-down 
menu. 

1. Point to the desired command in the Menu Bar and click 

or  

1. Press <ALT>  on the keyboard and the appropriate command's letter 
(underlined) 

2. Point to the desired option in the sub-menu and click 

or   

2. Type the letter that is underlined in the item name 

or  

2. Move the cursor to the option and press <Enter> 
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USING MENUS 

 

 

 

Dimmed: the option cannot be used at the 
current time. 

 

 

... following an option: indicates you will 
be asked for further information. 

 

 

 

ü to the left of the option, the option is in 
effect, when you choose the command 
again, the command is no longer in effect. 

 

 

A key combination to the right of a 
command shows the shortcut keys. 

  

 

 

Øto the right of an option: when you 
choose this command, another menu (a 
cascading menu) appears. 
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USING THE KEYBOARD 

If the mouse on the computer is disabled or you are an experienced keyboard user 
then you can use the keyboard instead of the mouse for many common tasks. Below is 
a table of the keyboard operations that can be carried out. 
 

Keys to press on 
the keyboard 

Tasks performed when keys are pressed 

CTRL+ESC Opens the Start menu 

ALT+ underlined 
letter 

Equivalent to clicking on the item on a menu or dialog box 

ALT+ESC  or 
ALT+TAB 

Switches between running programs 

ALT+ F4 Closes a program 

BACKSPACE In Explorer, goes up one level in the hierarchy 
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USING A DIALOG BOX 

Windows displays a dialog box when it needs additional information. Most dialog boxes 
contain options you can select. After you specify options you choose a command button 
to carry out an instruction. 

MOVING WITHIN A DIALOG BOX 

Click the option you want or press Tab to move clockwise or Shift+Tab to move 
anticlockwise through the options 

 

Tip: If the option, box, or button has an underlined letter in its name, you can choose 
that item by pressing the ALT key on the keyboard and typing the underlined letter. 

COMMAND BUTTONS 

Command buttons initiate an instruction. OK, Cancel and Help  are common command 
buttons. 

OPTION BUTTONS 

Option Buttons are mutually exclusive options. You can select only one option at a time. 
If you already have one option selected, your current selection replaces it. The selected 
option button contains a black dot.  

 

 

Option Buttons  

 

  

Command 
Buttons 
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TEXT BOXES 

Information is typed into a text box. When you move to an empty text box, an insertion 
point (flashing vertical bar) appears. The text you type starts at that insertion point. 

LIST BOXES 

A List Box displays a list of choices. If there are more choices than can be displayed in 
the box Scroll Bars are provided so you can move quickly through the list. 

DROP-DOWN LIST BOXES  

A Drop-Down List Box appears as a rectangular box containing the current selection. 
When you select the down arrow in the square box at the right, a list of available choices 
appears. If there are more items than can fit in the box Scroll Bars appear. 

CHECK BOXES 

A check box means you can select or clear an option. You can select as many check-box 
options as needed. When a check box is selected it contains an X. 

 

 

 

 

 

 

 

 

 

List Box 

Text Box 

Check box 

Drop Down List Box 
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CLOSING A DIALOG BOX 

When you choose a command button the dialog box closes and the command is carried 
out. You can also close the dialog box to cancel a command. 

SHUTTING DOWN YOUR COMPUTER 

Before closing down you should make sure you have closed all other open 
documents/windows first. 

 

1. Click the Start button and choose Shut Down 

 

 

Click Yes and after Windows NT tells you it is safe, turn off your computer  

IT IS VERY IMPORTANT IN WINDOWS NT TO SHUT YOUR COMPUTER 
DOWN IN THIS WAY.  IF THE PC IS NOT SHUT DOWN CORRECTLY THE 
PC MAY BE DAMAGED AND FILES ARE CORRUPTED.
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CLOSING DOWN NON RESPONDING APPLICATIONS 

If you press <Ctrl>, <Alt> and <Del> Windows NT will present you with the 
Windows NT Security Options. If for some reason an application has stopped 
responding press “Task Manager” bring up the following dialog box. 

 

If a program has stopped responding, the caption “Not Responding” will appear next 
to the program name.  To manually end the program click the mouse on the name, and 
press the “End Task” button.  This will force the program to close and free the 
system up. 

Although programs may experience errors, Windows NT itself will never stop 
responding.  Non responding programs should always be terminated in this way, 
removing the need to re-boot or turn off the computer. 
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EXERCISE  1 

USING THE COMMON ELEMENTS OF THE WINDOWS 
NT SCREEN 

This exercise will introduce you to the common elements of the Windows NT screen. 

1. From the Start button select Programs  

2. Select Microsoft Word  

3. Repeat steps 1 and select  Microsoft Excel 

4. Make Word the active application by clicking it on the Taskbar 

5. Type the following text 

Expenses Guidelines!! 

6. Minimise the Word to the Taskbar 

7. Bring the document back up by clicking onto it on the Taskbar 

8. Restore it down in size 

9. Move to the window corner and make the window smaller 

10.  Maximise the window  

11.  From the File menu select Save  

12.  Click Save  

Note: It will name the file Expenses Guidelines.doc we will name our files later in the 
course  

13.  Click into the text Expenses  

14.  From the Format menu select Change Case 

15.  Select Uppercase and then OK  

16.  Close Word using the System Button saving the changes as you go 

17.  Close Excel using the Close Button 
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ACCESSORIES 

• Calculator 

• Paint 
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CALCULATOR 

Calculator includes both a standard and a scientific calculator. When you start Calculator 
for the first time, the standard calculator appears. 

1. From the Start button select Programs  

2. Select Accessories and then Calculator 

 

3. Enter in your calculation by either clicking the calculator buttons with your 
mouse or press the desired numbers and symbols on the keyboard 

MATHEMATICAL SYMBOLS 

4. The computer uses different Mathematical Symbols to those that you are 
probably use to. This is not only in the calculator but all spreadsheets such as 
Excel. 

Argument Computer 
Symbol 

Add + 

Subtract - 

Times ∗ 

Divide / 
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PAINT 

Using Paint you can create simple or elaborate, black-and-white or colour drawings.  
After you have created a drawing, you can print it or  use it in another document (see 
Object Linking and Embedding). 

You use the tools in the Paint to create and change drawings.   

The following list provides a brief description of each tool's function.  

 

  
 FreeForm Select  Select 
 
 Eraser/Colour Eraser  Fill with Colour 
 
 Pick Colour   Magnifier 
 
 Pencil    Brush 
 
 Airbrush   Text  
 
 Line    Curve 
 
 Rectangle   Polygon  
 
 Ellipse    Rounded Rectangle 
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Tool Effect 

FreeForm Select To select an irregularly shaped area click the FreeForm Select 
  tool and then drag the cursor around the area 

Select   To select a rectangular area click the Select tool and then drag 
  the cursor diagonally across the area 

Eraser  Erases a picture using the selected Eraser shape 

Fill with Colour Fills a shape with the selected colour 

Pick Colour   Picks up a colour from the picture for drawing 

Magnifier  Changes the magnification 

Line  Draws a line one pixel wide 

Brush  Draws with a brush using the selected size and colour 

Airbrush  Draws using an airbrush of the selected size 

Text  Inserts text into the picture 

Line  Draws a straight line with the selected width 

Curve  Draws a curve with the selected width 

Rectangle  Draws a rectangle with the selected line width 

Polygon  Draws a Polygon with the selected fill 

Ellipse  Draws an Ellipse with the selected fill 

Rounded Rectangle Draws a rounded rectangle with the selected fill
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COPY/CUT/PASTE 

• The Clipboard Viewer 

• Copying 

• Cutting 

• Pasting 
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THE CLIPBOARD VIEWER 

Copy, Cut and Paste is a function that can be applied within a single document, between 
two different documents within the same application, or between separate documents 
within different applications. Whenever information is copied or moved it is 
automatically stored on the Clipboard. It will remain on the clipboard until the Paste  
command has been selected or until you switch off your computer. 

COPY 

1. Select the information to be copied 

2. From the Edit menu select Copy 
 
or 

2. Click the Copy button  

CUT 

1. Select the information to be moved 

2. From the Edit menu select Cut 
 
or 
 

2. Click the Cut button  

PASTE 

Once a Copy or a Cut command has been issued, the Clipboard Viewer will hold a copy 
of the data. To transfer the data to its new location the Paste command is used. 

1. Move the insertion point to where the information is to be placed 

2. From the Edit menu select Paste 
 
or 

2. Click the Paste button  
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 WINDOWS EXPLORER 

• What is the Windows Explorer? 

• Creating a new folder 

• Copying a file or folder 

• Deleting a file or folder 

• Formatting a disk 
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WHAT IS THE WINDOWS EXPLORER? 

The Windows Explorer is a powerful tool that helps you organise your files and 
Folders and see what files you have stored where. The Windows Explorer allows you 
to build or change your Folder structure and allows you to move files around within 
this structure. 

 

Hint: Ensure you are viewing the Explorer Toolbar. From the View menu select 
Toolbar. 
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ACCESSING WINDOWS EXPLORER 

1. Click on Start  

2. From Programs select Windows  Explorer  

or  

1. Right click the Start Button 

2. Select Explore  

ACCESSING NETWORK DRIVES 

1. Select the drop down arrow next to Go To Different Folder  

 

2. From the list select the desired drive 

or 

1. Scroll down the left hand side of the Window until you can see the required 
drive and double -click the drive icon   

 

COLLAPSING AND EXPANDING FOLDERS 

+ symbols represent the fact that Sub Folders are available  

  - representing that all Sub Folders are displayed  

 

 

1. Click the + or - signs to expand or collapse the 
view  

Note: Expanding the Folders does not open the Folder itself. 
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OPENING FOLDERS 

1. Click the yellow Folder once  

MOVING UP A LEVEL 

To move up the Folders structure a level or branch at a time there is a button on the 
Toolbar to help you. The Up One Level button. 

1. Click the Up One Level button  

or 

1. Press <Backspace> 

 

or 

1. Press Backspace  
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CREATING  A NEW FOLDER 

1. Select the Folder or Drive off of which you wish to create the Folder 

2. From the File  menu select New  

3. Select Folder 
 

 

4. Type in the folder name and press <Enter> 

Note: Windows NT will allow you to save Folders using up to 255 characters 
including spaces and case instructions. BUT when opening from the Folders inside an 
application it will only display the first 6 characters and then ~1. 

RENAMING A FOLDER 

1. Single click onto the Folder to select it 

2. Click into the name of the Folder so a border appears around it  

3. Type a new name 

4. Press <Enter> 
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TO MOVE A FILE OR FOLDER 

1. Select the file(s) or Folder(s) you want to move 

2. Click and Drag to the desired Folder 

or 

1. Select the file(s) or Folder(s) you want to move 

2. Click the Cut button 

3. Select the destination Folder and click Paste 

TO COPY A FILE OR FOLDER 

1. Select the file(s) or Folder(s) you want to copy 

2. Hold the <Cntl> key down and click and drag to the desired Folder ensuring 
you let the mouse go first 

or 

1. Select the file(s) or Folder(s) you want to copy 

2. Click the Copy button 

3. Select the destination Folder and click Paste 
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DELETING A FOLDER OR FILE 

1. Select the file or folder you want to delete  

2. Click the Delete button  

or 

2. Press the <Del> key on the keyboard  

3. Click Yes to confirm 
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EXERCISE 2 

CREATING A NEW FOLDER 

On completion of this exercise you will be able to access the Windows Explorer and 
create a new folder. 

1. From the Start button select Programs and Windows Explorer 

2. Maximise the window  

3. Move to the F:\ drive 

4. Scroll down to the Winword folder and select it  

5. From the File menu select New and select Folder 

6. Type Memos as the Folder name 

7. Press <Enter>  
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MANAGING FILES AND FOLDERS 

• Using the Find File option 

• Creating and using Shortcuts 

• Placing an Object on the Start menu 

• Removing an Object from the Start menu 
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USING THE FIND FILE OPTION 

1. Click the Start button and select Find 

2. Select Files or Folders   

 

3. In the Named box type in the file or folder name  

Hint - If you do not remember the full file name type as much as you can remember 
and it will find all the files whose name includes that text.   

4. Select the option Include Subfolders  

5. Choose the desired drive in the Look In box  

6. Click the Find Now button 

Hint: Windows lists all the files found. To open a file double -click it  

Hint - To begin a new search, click the New Search button and select OK to clear the 
current search. You can narrow your search by choosing the Date Modified or 
Advanced  tabs and specifying the appropriate file details.  
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EXERCISE 3 

FINDING FILES 

On completion of this exercise you will be able to use the Find File option  

1. Click the Start button and choose Find  

2. Select Files or Folders  from the menu  

3. Maximise the window  

4. In the Named box type in rhd  

5. Select the option include Subfolders  

6. Choose F:\ in the Look In  box  

7. Click the Find Now button 

Note: Windows lists all the files that have RHD in their titles. 

 

8. Double-click RHDModule2a  to open it  
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CREATING SHORTCUTS FOR PROGRAMS 

Shortcuts placed on the Desktop provide easy access to the documents and programs 
you use most often. 

1. Double-click on My Computer  

2. Ensure the window is restored  

3. Select the desired program file 

4. Click and drag onto the Desktop 

CREATING SHORTCUTS FOR DOCUMENTS 

1. Double-click on My Computer  

2. Ensure the window is restored  

3. Select the desired file 

4. Using the Right mouse Click and Drag onto the Desktop 

5. Select Create Shortcut 

Note: If  you Click and Drag a document using the left mouse it will move the file onto 
the Desktop. The right mouse ensures it is still stored in Explorer with additionally a 
Shortcut to it on the Desktop. 

USING A SHORTCUT 

1. Double-click on the Shortcut 

Note: It will automatically open the file the Shortcut was created for. 

‘ 

Hint - If you delete the Shortcut you do Not delete the file. 
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THE RHD NETWORK 

 

• What does the Network Do? 

• How is the Network Set Up? 

• The F Drive 

• Logging on to the Network 

• Saving Files on the Network 

• Opening Files on the Network 

• The MIS System 
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WHAT DOES THE NETWORK DO? 

The Network connects all the users of the computers in RHD together, enabling them to 
communicate, share files and resources.  The Network will serve all computer operations 
in RHD including e-mail, printing and the MIS system. 

By using this network you will be able to work as a team with other staff, and obtain 
access to a whole range of facilities and information.  By using a network like this, it is 
possible to save a great deal of time because all users can look in the same place for the 
same things.   

Please refer to the network presentation that we have prepared for a visual demonstration 
of what the network will do.  To look at this please click the icon on your desktop 
labelled “The RHD Network”.  Your training officer will demonstrate this to you. 

 

NETWORK USERS 

Although every computer on the network has access to the Network, different users will 
have access to different parts depending on what type of work they need to do.  When 
using the network you will only see the folders and files that you need to work with.  

Different people can be given different access to the network.  For example, a Director 
can look in certain parts of the network where other users cannot. 

The network is controlled to make sure all the users work in the right place and that all 
the files are organised. 

If you get a message saying that you do not have access to any part of the network (see 
below), this is because the files there are not necessary for your work.  
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HOW IS THE NETWORK SET UP? 

The network contains many resources for users, the most important being the file server, 
called RHD 1 .  The file server is like a large filing cabinet, designed to store all the work 
that is produced on the computers.  The good organisation of a network has very little to 
do with computers, it is simply about placing the right files in the correct places so that 
you and other users can find what you are looking for easily. 

The network user a number of different areas to store information.  On the network you 
will come across the following: 

Folders – Folders are represented by a small icon as shown above.  Folders are like 
very much like the paper folders we use in filing cabinets.  A folder is where we can 
put files for storage, or other folders.  The most important folders are found higher up 
in the order of the network.   

There are many folders on the network.  These have been set-up to store all the work 
that is produced.  Make sure when you are using the network to store your work in the 
correct folders. 

Files – Files are separate pieces of work on the network, and can be of many different 
types.  For example, a typed piece of work is likely to be saved as a Microsoft Word 
document.  Unlike folders, files on the network have a different appearance depending 
on what type of work they relate to.  The pictures above show examples of a Word 
Document, Excel Spreadsheet and PowerPoint Presentation.  When you begin to use 
the network you will eventually be able to automatically recognise files by their 
appearance. 

When you save in any program you create a file.  The type of file depends on the 
program you are working in.  There are many more files than folders on the network. 

Files are stored in folders, and storing the correct files in the correct folders is 
essential if the network is to be properly managed.  If you are not sure where to put a 
file you have made, please ask the network administrator. 

Files and Folders are the only two things you will find on the network.  Although files 
can be of many different types, they are stored and organised in exactly the same way.  
To use the network well all you must do is learn how folders and files work.  If you 
remember that folders are for storing files, and work just like an electronic filing 
cabinet, it should by easy to organise your work correctly.  
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THE F DRIVE 

The main file server in RHD is known as the F Drive .  The F Drive contains all the 
data for all of the computer users.  Every computer user in RHD is connected to the F 
Drive. 

In order to ensure that the F Drive is used correctly different people will be connected 
to different areas of the drive.  For example, if you work within GIS, you will be 
connected to the GIS directory of the F Drive, as shown below: 

 

When you access the F Drive, a list of folders will appear which are relevant to your 
work.  The example above is work GIS users.  By taking you straight to the correct 
place on the network, it will be easier and quicker for you to save and retrieve work.  

The network administrator will make sure that your computer looks at the right place 
on the network and that everything is set-up correctly. 

If for any reason you feel you do not have access to folders or files which you need, 
please raise this question with the network administrator who will be able to review 
and modify your network access if necessary.  
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EXPLORING THE F DRIVE 

When you are connected to the F Drive you may look at all the files and folders that 
are there.  To look in a particular folder, you double click the mouse on the folder you 
wish to look inside.  For example, in the GIS folder, if we wished to look at the 
contents of the folder Dhaka_Zone, we would double the click the folder : 

  

As you can see, a list of further folders and files has now appeared.  Clicking on 
another folder will then display the contents a further level deeper.  If you wish to go 
back to look at the folders above, click the button shown here :  

Learning how to look at the network properly is very important, and  
it is necessary to practice until you are able to move around properly.  

BENEFITS OF THE F DRIVE 

It is very important to save your files on the F Drive for a number of reasons.  Firstly, 
by using the same drive it is possible for other users to access the same work so 
computer users are able to work as a team.  You can be confident that work you save 
will only be accessed by those who have been given authorisation, and no-one will be 
able to access your files unless they have been allowed by the network administrator. 

One of the most important reasons we use an F Drive is to make sure that work is not 
lost by mistake.  Every day the files and folders on the drive are copied to a tape 
which safeguards against loss of any data.  If you do not save on the network, your 
computer may fail and all your work will be lost.  It is very important to save on the 
network to ensure that data is safe. 
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VIRUSES 

In a country such as Bangladesh, where a great deal of pirated software is used and 
ISP’s are in their infancy, there is a very real risk of damage to a network installation 
through viruses.  It is essential that every precaution MUST be taken to prevent 
viruses entering the network.  The chief dangers come in the form of e-mail and 
floppy disks. 

Your computer has various checking software installed, which will look at all the files 
on your system and warn you if there are any viruses detected.  This software is called 
NetShield.  If you receive any warning from NetShield you must contact your 
network administrator immediately.  Please make sure that in the right bottom 
corner of the screen (call system tray) any or all the following icons will appear all the 
times. 

 

If  you do not see any of these icons in the system tray or if they look as below  you 
must contact your network administrator immediately. 

If a virus infects your computer it can also infect the entire network, damaging the file 
and folders of ALL users.  You must exercise extreme caution in relation to viruses. 

If you receive any e-mail that has a file attached, please do not open the file unless 
you are 100% sure that the file is from a reliable source.  E-mail is the main way 
viruses are transmitted and great care is necessary to stop this happening.  You must 
also be very careful with floppy disks, which are another main source of viruses.  If 
you have any doubts regarding a disk, please ask your network administrator to check 
the disk first. 

It is the responsibility of all users to keep the network virus free and everybody 
has a role to play in this aim. 

 

WHAT TO SAVE ON THE NETWORK 

You should save all files and documents that are relevant to your work on the 
network.  You should not save any files of a personal nature. 

Please do not save very large files on the network unless it is essential.  If you 
have a large file please alert your network administrator before storing it on the 
network.  Large files that are saved randomly may be deleted if the network 
administrator cannot determine whom it belongs to.  

Please use the F Drive responsibly and try to keep all files organised. 
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LOGGING ONTO THE NETWORK 

In order to get access to the network you must log-on using a username and password.  
This username and password is given to you personally and will make sure that you 
can access the correct part of the network.  A username will be given to you following 
your certification as a network operator.  You will be able to decide on any password 
you like. 

When you start the computer the system will load, and after a couple of minutes the 
NT log-on screen will appear.  You must press CTRL + ALT + DELETE (at the 
same time) to proceed to the log-on dialog. 

When the dialog appears you must now enter a username and password.  The first 
time you log-on your password will be simply “password”.  You will then be asked to 
change your password, confirming the new password twice.  You are free to choose 
any password you wish.  Next time you log-on you must enter this new password.  
You must not give your password to any other user.  If you forget your password 
at any stage you must contact the network administrator you will be able to help you. 

Note: When you log on to the network you must type your username and password in 
lower case.  Make sure that the CAPS LOCK key is not on when you are typing. 

Once the log-on process is complete you the computer will load some files before 
displaying your normal desktop.  At this point you are free to begin your work.  You 
will have been connected to the F Drive by the system. 

SHUT DOWN  

When you have completed your work and wish to close down your computer you 
must Shutdown.  To do so please click on the Start button, and select Shut Down… 

 

Click OK or Yes (whic h one is applicable) to shut the computer down.  The computer 
will turn itself off automatically.  It is very important to log off in this way and you 
should never just turn the computer off. 
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SAVING FILES ON THE NETWORK 

When you are using the network it is very important to save your files in the correct 
place to keep things organised.  When you are ready to save your work you use the 
Save command in whichever program you are using.  For the purposes of training, we 
will assume that the user is trying to save a document in Microsoft Word.  

1. Click on the Save  button:   

or From the File menu select Save. 

2. Select the required drive and folder, then type a filename. If you need a 

new folder click the new folder button:    

3. When you have the right place to save your work Click OK.  If you are 
not sure where to save your work, or do not understand how to find 
the correct folder, please consult the network administrator. 

SAVING THE DOCUMENT WITH A DIFFERENT NAME OR TO A 
DIFFERENT LOCATION 

4. From the File  menu choose Save As. 

5. Follow the steps above to give the file a new name or to store it in a 
different location. 

6. From now on (in this document) click on the Save  button  to update 
the changes to your work. 

Use this arrow to display the 
folders on the F Drive 
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OPENING A DOCUMENT ON THE NETWORK 
 

This is a very similar procedure to saving a document.  Again the example shown 
relates to opening a document in Microsoft Word. 

1. Click the Open button:  

or From the File menu select Open. 

2. Select the folder in which your document is kept in the  
Look In  box. 
 

 

3. Click on the file name, and click OK 

or Double-click on the file name. 

Type the first character of the filename and Word will 
jump to the files beginning with that letter 
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MIS (MANAGEMENT INFORMATION SYSTEM) 

The MIS system is available to all users of the network and provides many facilities.  
There are many components to the system. 

• The system includes a wealth of information, including: 
- road network information 
– organisation structure 
– staff records 
– road and bridge management systems 
– mechanical plant information 
– equipment and ferries information 
– contract reporting system 
– financial reporting system 
– asset management system 
– access to GIS maps 
– standard documents and presentations 
– external publications 
 

You will be able to access all parts of the system that are relevant to your work. 

To access the MIS click on the logo on your desktop which looks like this: 
 

The MIS system is web based and you access it through the Internet Explorer.  
To find what you are looking for in the system you must simply click on the correctly 
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labelled buttons. 

 

You can generate reports on screen and on the printer by selecting criteria : 

 
You can also access maps which you can click to show you more detailed maps for 
each division. 
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It is also possible to create graphs to analyse data which can also be printed from your 
own computer. 

 

 
 
The MIS offers many resources and will be useful for all RHD staff.  The system is 
being constantly developed and as the network grows will assume even more 
importance. 
 
As the MIS develops further training will be available to illustrate the many features 
and functions of this resource. 
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INTRODUCTION 

E-mail is a very important part of using the network.  It allows you to send messages 
quickly and easily both to all other users of the network, and also to anyone in the world 
with an e-mail address.  E-mails are the most widely used form of communication in 
business today, and one of the main reasons we have a network in RHD. 

 

Exploring Outlook™ Express

  
The Outlook™  Express environment is the screens and layout you use 
to work. You can work with Outlook™  Express’ default environment 
or customize it to suit your needs. 

 
When you start Outlook™  Express a similar screen appears:  
 
You can customize how this screen looks by changing its layout. To 
do this, click the View pull-down menu and select Layout. Check off 
items to appear or not appear on your screen. You can also add groups 
and folders to the Folder List (see Add Folders to Folder List in this 
section for more information). 
 
You can use keyboard shortcuts for everything from selecting menu 
commands to moving between the Folder List and the Preview Pane. 
For more information, look up Keyboard Shortcuts in Help 
Contents and Index. 

Preview
Pane

Folder

Toolbar

Icon Links Bar 

Status 
 Bar 

Pull-down 
Menus

Folder
List
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Folder List 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

 

Note: To permanently 
delete an item from the 
server, first mark it for 
deletion (click Delete  in 
the toolbar). This marks 
the item for deletion. 
From the Edit pull-down 
menu, select Purge 
Deleted Messages.  

The Folder List contains folders like Inbox, Outbox, Sent Items, 
Deleted Items, and Drafts, and can be customized to include others. 
 
Folders 

There are five default folders in the Folder List: The below images are 
much larger than they will appear in your Folder List. 
 

 
Inbox  Stores new email until you remove it.  

The Inbox stores all email that is on the 
server and can be accessed from any 
configured computer. 
 

 

Sent Mail or 
Sent Items 
 
 

Stores a copy of each sent email item.  
Outlook™  Express uses the Sent Items 
in the Outlook™  Express section of the 
Folder List. 
 

 
Outbox Temporarily stores mail after clicking 

the Send button on a new email.  
To send stored mail to its destination, 
you may need to click the Send and 
Receive  button in the toolbar.  
Outlook™  Express uses the Outbox in 
the Outlook™  Express section of the 
Folder List. 

 

 

Deleted 
Items 
 

Stores deleted items you empty it.  
To empty the Deleted Items folder, 
right-click it and select Empty Folder.  
Outlook™  Express uses the Deleted 
Items in the Outlook™  Express section 
of the Folder List. 
 

 
Drafts  Stores drafts of unfinished email 

messages until you can finish them.  
Outlook™  Express uses the Drafts in 
the Outlook™  Express section of the 
Folder List. 
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Expand Folder List 

When you click the plus sign next to a folder, a drop-down list of 
subfolders appears and the plus symbol becomes a minus symbol to 
show the folder is open. The following illustration displays this 
feature. 
 

 
 
Drop-down Folder List 
 
 
 

Preview Pane  
 

When you first open Outlook™  Express, the Preview Pane contains 
icons similar to those in the toolbar. These icons include Read Mail, 
Read News, Compose Message, Address Book, Download All, and 
Find People. 
 

 
 
Initial view of the Preview Pane 
 

 

Read Mail  Opens your Inbox folder. If you have 
not yet set up Outlook™  Express to run 
email, it will take you to an email setup 
process. 

 

 

Read News Opens your newsgroups folder. If you 
have not yet set up Outlook™  Express 
to run news, it will take you to a 
newsgroups setup process. 
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Information 
Viewer  

 

 

Compose  Brings up a new email message for you  
Message to compose. 
 

 
Address 
Book 
 

Keeps track of email addresses, contact 
information like street addresses and 
phone numbers, notes, and web page 
addresses. 
 

 

Download  Downloads email and news from all  
All your accounts. 
 

 

Find Helps you find individuals in your  
People Address Book or the Internet. 
 

 
When viewing messages in the Preview Pane, you can press the Tab 
key to move between the Preview Pane and the Folder List. 
You can split the preview pane horizontally, vertically, or not display 
it at all. In the View menu, click Layout and choose the Preview Pane 
options you want. 
The initial view of the Preview Pane (with the above icons) will 
disappear when you click out of it or perform an action. To retrieve 
this menu view, click Outlook Express in your Folder List. 
 
 
When you click a folder in the Folder List its contents are displayed to 
the right in the Information Viewer. 
 

 

Information 
Viewer 

Email Item 
Selected

Email Item 
Displayed in a 
Preview Pane

  Folder List 
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Toolbar 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

USING EMAIL 
 
Reading Email 

The standard Outlook™  Express toolbar allows quick access to many 
Outlook™  Express features. The active buttons shown on the toolbar 
depend on your current activities. Forwarding and Receiving, for 
example, are only available when viewing email messages. The 
following is a list of common buttons. 
 

 
Compose a  Brings up a new email message for you  
Message to  compose. 
 

 Reply to  Responds to an email message. 
Author 
 

 Reply to All Responds to an email message and all 
recipients of the original message. 

 
 Forward   Sends a received email message to  

Message someone else. 
 

 Send and  Checks for new email messages and  
Receive sends off any email messages contained 
 in the Outbox. 
 

 Delete  Deletes an unwanted email message. 
 
 

 Address Book 
Book 
 

Keeps track of email addresses, contact 
information like street addresses and 
phone numbers, notes, and web page 
URLs. 

 
To configure the buttons you see in your toolbar, right-click a button 
and select Buttons. Follow the directions for changing the buttons in 
your toolbar and click Close. 
 
 
With Outlook™  Express you can easily send, forward, and reply to 
email; use the Address Book; and print your email 
 
Outlook™  Express stores your incoming mail in your Inbox. You may 
need to click Send and Receive in your toolbar before your Inbox can 
be updated. 
 
To access your email, click the Inbox folder in the section of your 
Folder List. The Inbox displays headers to your email messages in the 
Information Viewer. Click a header, or highlight it, and the email 
message will be displayed at the bottom of the window. To see an  
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Send and Receive 
 

 
Attachment 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Sending Email 
 

 
Compose Message 

Tip: To make creative 
messages, click the down 
arrow to the right of 
Compose Message and 
select an option. It adds a 
stationary image behind 
the email body. 
 

email message displayed in a separate window, double-click its 
header. 
 
A torn paper icon next to an email header indicates that the message 
body has not been downloaded. A whole paper icon indicates that the 
message is available for reading, even if you are off-line (not 
connected to the Internet). 
 
New Mail Arrival 

To check for new email you may need to click the Send and Receive 
button in your toolbar. This sends any pending messages in your 
Outbox, and checks for new email. New email is stored in the Inbox.  
 

Read Attachments 
Attachments are files that are sent with email messages. If your email 
header includes a paper clip symbol, double-click the message header 
to open the email. At the bottom of the email message will be the 
attached file. Double-click the file; it opens in the associated program. 
An example of an attached file is given below: 

 
 
 
Outlook™  Express can help you send email to anyone with an email 
address.  
 
Create a New Email Message 

Send an email message to someone: 
1. Be sure your Inbox folder is open. Click the Compose Message 

button. A blank message appears. Your screen should look 
similar to the illustration on the next page. 

2. Fill in a topic title for Subject and type your message in the 
open message area. 

Attached File 



Module 2b – OUTLOOK EXPRESS  Page 19 of 25 
 

RHD NETWORK CERTIFICATION  
MODULE 2B – OUTLOOK EXPRESS  

  
 

 
Blank Message

 

 
 
 

 
Address an Email Message 
 

Once you have created an email message, you can address the 
message in the following ways: 

 
• Type the Email Address 

Enter the email address (such as mcarrick@stewarts-
solictors.co.uk) into the To: field of a message. 

 

• Type the Email Recipient’s Name 
Enter the name of the person whom you are sending email. If 
the person’s name is included in a personal address book, or if it 
is in a directory service set to check names, Outlook™  Express 
will underline the name to show it recognizes the email address.  

 

 
   Select Names 

• Retrieve Name from Your Personal Address Book  

The personal Address Book contains personal addresses. Use 
your Personal Address Book for adding names to messages: 

1. While composing a message, click the icon next to the To: 
section of the message.  
The Select Recipients window appears (see picture below).  

2. Highlight and select the desired name and click the To: 
button. Click OK. Your message is now addressed with the 
selected name. 

Enter the email 
address in this field 

Click this icon to choose an e-mail 
address from the Select Recipients
window (your Personal Address 
book). 

Note: Selecting a name and 
clicking the To button sends the 
email message to the selected 
person. Selecting a name and 
clicking the CC button sends a 
“carbon copy” to someone in 
addition to the original person. 
Selecting a name and clicking and 
clicking the BCC button sends a 
“blind carbon copy” to someone in 
addition to the original person 
without the original person 
knowing.  



Module 2b – OUTLOOK EXPRESS  Page 20 of 25 
 

RHD NETWORK CERTIFICATION  
MODULE 2B – OUTLOOK EXPRESS  

  
 

Attach a file 

Once you have created an email message, you can attach a file with 
the following steps: 

 
1. Click the Insert pull-down menu and select Insert 

Attachment. 
2. Find and highlight the file you would like to send via email. 

Click Attach. The chosen file is added to the email message 
area. 

 
Send Email  
 

Once you have the email message written and addressed, click the 
Send button to deliver the message. The message may first be stored 
in the Outbox. If the message is sent to your Outbox, click the Send 
and Receive button in the main toolbar for Outlook™  Express to send 
the email to its destination. 
 
 
Summary 

To send an e-mail message 

1. On the toolbar, click the New Mail button.  
 
2. In the To and/or Cc boxes, type the e-mail name of each 

recipient, separating names with a comma or semicolon ( ; ).  
To add e-mail names from the Address Book, click the book 
icon in the New Message window next to To, Cc, and Bcc, 
and then select names. 
To use the Bcc box, click the View menu, and then select All 
Headers. 
 

3. In the Subject box, type a message title.  
 
4. Type your message, and then click the Send button on the 

New Message toolbar.  

Tips 

• To save a draft of your message to work on later, click the File 
menu, and then click Save. You can also click Save as to save 
a mail message in your file system in mail (.eml), text (.txt), or 
HTML (.htm) format.  
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Responding to 
Email 

 
 
When you receive email messages, you may choose to reply (send a 
response) or forward (send received mail to someone else). You can 
do this by selecting or opening a message and using the toolbar to 
direct your response. 
 

 
Forward Message 

Forward a Message 

1. Select or open the email message to forward. 
2. Click the Forward Message button. 

A new mail message appears. 
3. Address the message and click Send. 

The message is forwarded. 
 

 
 
 
 
 
 

Reply to the Author of a Message 

1. Select or open the email message to which you are replying. 
2. Click the Reply to Author button. 

A new mail message appears. 
3. Address the message, type your response, and click Send. 

The message is sent to the author of the original message. 
 
 
 

 
 
 

 
Reply to All 

Reply to the Author and Recipients of a Message 

1. Select or open the email message to which your are replying. 
2. Click the Reply to All button. 

A new mail message appears. 
3. Address the message, type your response, and click Send. 

The message is sent to the author and all recipients of the 
original message. 

 
 

Saving Email You may want save your email messages into folders, either in 
Outlook™  Express or on your hard drive. An easy way to save email 
messages is by dragging them to a folder in your Folder List (to create 
folders see Add Folder to Folder List in the Exploring Outlook™  
Express section in this guide).  
 
Save an Email Message to a Folder 

1. Make sure your information viewer shows the message you 
want to save. 

2. Make sure you can see the folder where you want to save the 
message. 

3. Click the email message and drag the message to the folder. 
The email message is copied to the folder. 

 
Reply to Author 
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You can also save an email message by highlighting the letter header 
then dragging it to your desktop or to an open folder. 
 
Save Email Message Text  
To save text from an email message to use in a word processor or 
other program, you need to save the message text in another format 

1. From the information viewer, double-click the email message 
header. 
The email message opens. 

2. Click the File pull-down menu and select Save.  
The Save As window appears. 

3. Name the file and click Save. The file is saved in Rich Text 
Format, which maintains the format of the text. It can be opened 
in word processors and other programs. 

 
 

Printing  
 

 
Print 

You may want to keep a paper copy of an item rather than saving it to 
a folder.  
To print an item, highlight the message header or open the item. If the 
Print button appears in your toolbar, click it. If it does not, click the 
File pull-down menu and select Print.  
 
 

Managing Sent 
Mail 

 
 

You may need to view messages you have already emailed. If you 
have sent the email, but do not know if it has actually been sent to the 
person(s) yet, check the Outbox in your Outlook™  Express section of 
the Folder List. Items are stored here until you click the Send and 
Receive  button in the toolbar. Sent Items  (found directly under the 
Outlook™  Express section of the Folder List) stores a copy of the sent 
item. 
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Outbox 

The Outbox folder contains all pending email items. Click the Send and Receive button 
in the toolbar to send items in the Outbox to their destinations. To view items in the 
Outbox, click the Outbox folder in the Outlook™  Express section of the Folder List. The 
items are listed to the right in the Preview Pane. 

 
 
Sent Items 

The Sent Items folder contains all email successfully sent to other people. To view items 
you have sent, click the Sent Items  folder in the Outlook™  Express section of the Folder 
List. The items are listed to the right in the Preview Pane. 
 
If you think an item should be in your Sent Items box but it is not, check your Outbox. 
Items may be stored in your Outbox until you click the Send and Receive button in the 
toolbar. 
 

 

Adding to Personal Address Book  
 
 
You can add to your personal address book manually 

 add names manually, click Address Book in the toolbar and choose: 

 
• To add an individual to your Address Book, click the New Contact 

button in the toolbar of your Address Book. 
 
 

• To add a group to your Address Book (for sending to more than one 
person at a time) click New Group. 

 
 

New Contact 

New Group 
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EXERCISE 1 

LOGGING ON TO AND SHUTTING DOWN  
YOUR COMPUTER 

The training officer will supply you with a username and password for the purposes of 
this exercise.  Following your certification you will be given your own username and 
password to use from now on.  Using your test username and password, complete the 
following steps. 

1. Turn on the Computer using the appropriate button. 

2. Wait for Windows NT to load 

3. When the system has stopped loading, press log-on using your username and 
password. 

4. Wait for the system to load. 

5. Shut-down the computer using the correct procedure. 
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EXERCISE 2 

ACCESSING THE F DRIVE 

This exercise will let you access the main F Drive.   

1. From the Desktop select  My Computer  

2. Maximise the window 

3. Move to the F:\ drive 

4. Move into the Winword folder 

5. Double click on the file rhdword.doc 

6. Microsoft Word will load the file 

7. Close Microsoft Word 
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EXERCISE 3 

SAVING A FILE 

This exercise will involve saving a MS Word file on the network. 

1. From the Start button select Programs and Microsoft Word 

2. Maximise the window 

3. Type the Text : Word File to be Saved! 

4. Click on the Save Button  

5. Save the document in the following folder: f:\certfication\exercises\ 
with the filename wordfile.doc 

6. From the File menu select Save As 

7. Save the document in the following folder: f:\winword\exercises\ 
with the filename wordfile1.doc 

8. From the File menu select Close 

You have now created the file and saved it in two different places 
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EXERCISE 4 

DELETING FILES 

Using My Computer, this exercise involves deleting files from the network: 

PLEASE NOTE YOU SHOULD NOT DELETE FILES FROM THE NETWORK 
WITHOUT AUTHORISATION FROM YOUR NETWORK ADMINISTRATOR. 

1. From the Desktop select My Computer.  

2. Move to the folder the F Drive 

3. Move to the folder f:/certification/exercises 

4. Click on the file called wordfile.doc  

5. Press the delete button, or click the on the delete icon 

6. Press Yes to confirm the delete 

7. Repeat the process to delete the file f:/winword/exercises/wordfile1.doc 

 

You have now deleted the file from two different places. 
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EXERCISE 5 

E-MAIL (MICROSOFT OUTLOOK) 

Using Outlook Express, this exercise involves sending e-mail: 

 

1. From the Desktop select Outlook Express.  

2. Click on the New Mail icon to start an e-mail. 

3. Create a simple e-mail, to the address given to you by the training officer. 

4. Attach the file called f:/certification/exercises/attach.doc  

5. Click the following icon to send the message 

 

6. Move to Sent Items  to confirm the e-mail has been sent 

7. Check for new mail using F5 

 
 



Module 3 – EXERCISE  Page 6 of 6 
 

RHD NETWORK CERTIFICATION  
MODULE 3 – CERTIFICATION QUESTIONS 

 

 
 
 

EXERCISE 6 

 

MIS (MANAGEMENT INFORMATION SYSTEM). 

This exercise will involve using the MIS (Management Information System). 

 

 

1. From the Desktop select MIS. 

2. Click on Services 

3. Use the system to look at a detailed map of  Dhaka Division. 

4. Print the map using the software. 

5. Close the system down in the appropriate way. 

 



Note :    
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